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MICREX-SX Series Ethernet Driver

Introduction
This manual describes how to connect the Display and the External Device (target PLC).
In this manual, the connection procedure will be described by following the below sections:

1 || System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

&g System Configuration" (page 3)

2 Selection of External Device

Select a model (series) of the External
Device to be connected and connection
method.

"2 Selection of External Device" (page 5)

3 Example of Communication Settings
This section shows setting examples for
communicating between the Display and
the External Device.

&3 Example of Communication Setting"

(page 6)

4 Setup ltems

This section describes communication
setup items on the Display.

Set communication settings of the Display
with GP-Pro Ex or in offline mode.

Fny Setup Items" (page 10)

Operation
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MICREX-SX Series Ethernet Driver

1 System Configuration

The system configuration in the case when the External Device of Fuji Electric Co., Ltd. and the Display are
connected is shown.

Series CPU Link I/F SIO Type Setting Example
SPH200 "Gt "
(NPLPH-08 / NP1L-ETL (Sae“;”e% Example 1
NP1PH-16) pag
SPH2000 "Setting Example 1"
(NP1PM-48R) NPIL-ETL (page 6)
. "Setting Example 2"
SPH2000 Ethernet port on CPU Unit (age 8)
(NP1PM-48E / -
SPH NP1PM-256E) NP1L-ET1 Ethernet (TCP) "Setting Example 1"
(page 6)
SPH300
(NP1PS-32/
NP1PS-32R /
NP1PS-74/ "Setting Example 1"
NP1PS-74R / NPIL-ETL (page 6)
NP1PS-117 /
NP1PS-117R/
NP1PS-245R)

B Connection Configuration

e 1:1 Connection

Display
External Device
[ ]
HUB
¢ 1:n Connection
The max number of External Device : 16
Display ~ ~ ~
External Device External Device
[ ] [ ]

l J J

HUB
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MICREX-SX Series Ethernet Driver

¢ n:1 Connection

The max number of Display : 56

Display Display

N

External Device

[ )

l J

HUB

¢ n:m Connection

56 Displays mammumPer 1 External Device 16 External Devices maximum per 1 Display

Display Display R - ~ Y
External Device External Device
( ] [ )

l J J

N

NOTE « A maximum of 8 Displays can be connected to one Ethernet unit.
« A maximum of 10 Displays can be connected to one CPU unit.

HUB

* When using multiple CPU units and Ethernet units simultaneously, a maximum of 56 Displays
can be connected. The greater the number of Display connected, the more the communication
load increases.

* When 2 or more displays are connected to one External Device, the error below may be
displayed when 2 or more Displays are activated simultaneously.

"Error has been responded for initial communication command (Error Code:[Hex])"
If an error occurs, the error will automatically recover after a certain period of time has passed
and normal communication will resume.
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MICREX-SX Series Ethernet Driver

2 Selection of External Device

Select the External Device to be connected to the Display.

#* Welcome to GP-Pro EX [x]
4 Device/PLC
» evice,
GP-ProlE ! |

Mumber of Devices/PLCs |1 3: ‘g
Device/PLC 1

Manufacturer | Fuj Electric Co. Ltd. |L

Series MICRE-5x Series Ethemet E

Fart Ethemet (TCF) [+
Eefer to the manual of this Device/PLC
Eecent Device/PLC

A ¥

I Use Spstem Area Drevice Information

Back [B] | Communication Settings | Mew Logic | Mew Screen I Cancel

Setup Items Setup Description

Number of Devices/ Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

PLCs

Manufacturer Select the manufacturer of the External Device to connect. Select "Fuji Electric Co., Ltd.".
Select the External Device model (series) and the connection method. Select "MICREX-SX
Series Ethernet”.

Series In System configuration, make sure the External Device you are connecting is supported by
"MICREX-SX Series Ethernet".

& System Configuration” (page 3)
Port Select the Display port to connect to the External Device.

Check this option to synchronize the system data area of the Display and the device (memory)
of the External Device. When synchronized, you can use the External Device’s ladder program
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area]

Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"

Use System Area
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MICREX-SX Series Ethernet Driver

3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are
shown.

3.1 Setting Example 1
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |Fuii Electric Co. Ltd. Series MICRE-5% Series Ethernet Port |Ethemet [TCP)
Text Data Mode ’T LChange

Communication Settings

Part Na. 3 W Auto
Timeout 3 3: [sec]
Retry 0 3:

‘what To Send 0 3: [ms] Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l 1P Adhess=192.163.000.001 Part No.=1024

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ . To connect multiple External Devices, from
[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

&* Individual De
PLC1
IP Address 192 168 0 1
Part Mo. 1024 3:

Fleaze zet the value that you add “'251" to the port
number you have set for the Device/PLC.

‘ariable Data
[ Use Wariable Data

| =l
| |
Default

0K | Cancel |

NOTE « For the port number, set the value that "251" is added to the set port number with External
Device.

For example, if "773" is set to the port number with External Device, set "1024" to the port
number of Device Setting.

GP-Pro EX Device/PLC Connection Manual 6



MICREX-SX Series Ethernet Driver

B Settings of External Device

Use the ladder software SX-Programmer Expert (D300win) for communication settings.
Please refer to the Micrex-SX Series D300Win users manual by Fuji Electric Co., Ltd. for more details.
1 start up the D300win.
2 Select [New Project] from the [File] menu and select template of using CPU from the New Project dialog.
3 Double click [System Definition] of the project tree to display the system definition screen.
4 Select [Insert] from the displayed menu indicated after right-clicking the CPU.
5 Select Ethernet interface module to be used from [Outline Specification] of the displayed [Module insert] dialog
box and register it to the system definition.
6 Right click Ethernet interface module and select [Properties] from the displayed menu.
7 Click [Parameter] of the [Module properties] dialog box.
8 Select [IP Address] tub of [Ethernet Parameter] dialog box.
9 Input IP address and subnet mask as shown below in [IP Address].

Setup ltems Setup Description
IP Address 192.168.0.1
Subnet mask 255.255.255.0

10 Select [Detail Setting] of [Ethernet Parameter] dialog box.
11 Select [Self port standard No.] and input "773" to the port number above Ethernet interface module.

- For the port number of Device Setting for GP-Pro EX, set the value that "251" is added to the
set port number.
For example, if "773" is set to the port number, set *1024" to the port number of Device
Setting for GP-Pro EX.

12 Select [Exit] from [File] menu on the system definition screen.

13 Select [Make] from [Build] menu and compile the project.

14 Select [Project Control] from [Online] menu and click [Download].
15 Select all items to be downloaded and click [OK].

16 After download is executed normally, click [Reset].

Now communication setting is completed.
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MICREX-SX Series Ethernet Driver

3.2 Setting Example 2
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |Fuii Electric Co. Ltd. Series MICRE-5% Series Ethernet Port |Ethemet [TCP)
Text Data Mode ’T LChange

Communication Settings

Part Na. 3 W Auto
Timeout 3 3: [sec]
Retry 0 3:

‘what To Send 0 3: [ms] Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l 1P Adhess=192.163.000.001 Part No.=1024

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ . To connect multiple External Devices, from
[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

&* Individual De
PLC1
IP Address 192 168 0 1
Part Mo. 1024 3:

Fleaze zet the value that you add “'251" to the port
number you have set for the Device/PLC.

‘ariable Data

[ Use Wariable Data

| =l
| |
Default

0K | Cancel |

NOTE * For the port number, set the value that “251" is added to the set port number with External
Device.

For example, if "773" is set to the port number with External Device, set "1024" to the port
number of Device Setting.

GP-Pro EX Device/PLC Connection Manual 8



MICREX-SX Series Ethernet Driver

B Settings of External Device
Use the rotary switch of Ethernet port on CPU unit and the ladder software SX-Programmer Expert (D300win) for

communication settings.
Please refer to the Micrex-SX Series D300Win users manual by Fuji Electric Co., Ltd. for more details.

@ Rotary Switch Settings
Set "0" to the rotary switch of Ethernet port on CPU

€ Ladder Software Setting

1 Start up the D300win.

2 Select [New Project] from the [File] menu and select template of using CPU from the New Project dialog.
3 Double click [System Definition] of the project tree to display the system definition screen.

4 Select [Properties] from the displayed menu indicated after right-clicking the CPU.

5 Click [Parameter] of the [Module properties] dialog box.

6 Select [IP Address/Gateway Setting] tub of [CPU Parameter] dialog box.

7 Input IP address and subnet mask as shown below in [IP Address/Gateway Setting].

Setup Items Setup Description
IP Address 192.168.0.1
Subnet mask 255.255.255.0

8 Select [Detail Setting] of [IP Address/Gateway Setting] tub.
O Select [Self port standard No.] and input "773" to the port number of Ethernet port above CPU unit.

« For the port number of Device Setting for GP-Pro EX, set the value that "251" is added to the
set port number.
For example, if "773" is set to the port number, set *1024" to the port number of Device
Setting for GP-Pro EX.

10 Select [Exit] from [File] menu on the system definition screen.

11 Select [Make] from [Build] menu and compile the project.

12 Select [Project Control] from [Online] menu and click [Download].
13 Select all items to be downloaded and click [OK].

14 After download is executed normally, click [Reset].

Now communication setting is completed.

GP-Pro EX Device/PLC Connection Manual 9



MICREX-SX Series Ethernet Driver

4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.
The setting of each parameter must be identical to that of External Device.

&3 Example of Communication Setting" (page 6)

NOTE « Set the Display’s IP address in offline mode.

Cf.  Maintenance/Troubleshooting Guide "Ethernet Settings"

4.1 Setup Items in GP-Pro EX

B Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |Fuii Electric Co. Ltd. Series MICRE-5% Series Ethernet Port |Ethemet [TCP)
Text Data Mode ’T LChange

Communication Settings

Part Na. 3 W Auto
Timeout 3 3: [sec]
Retry 0 3‘

‘what To Send 0 = [ms] Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device

1 [ [l 1P Adhess=192.163.000.001 Part No.=1024

Setup ltems Setup Description

Use an integer from 1024 to 65535 to enter the port No. of the Display. When you check

Port No. the option of [Auto], the port No. will be automatically set.

Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the

Timeout response from the External Device.

In case of no response from the External Device, use an integer from 0 to 255 to enter how

Retry many times the Display retransmits the command.

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

Wait To Send packets to transmitting next commands.

NOTE « Refer to the GP-Pro EX Reference Manual for Indirect Device.
Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

GP-Pro EX Device/PLC Connection Manual 10




MICREX-SX Series Ethernet Driver

B Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ . To connect multiple External Devices, from
[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

&* Individual Device Settings

PLC1

IP &ddress I 192 168, 0. 1
Part N, |1024 ﬁ

Fleaze zet the value that you add “'251" to the port
number you have set for the Device/PLC.

‘ariable Data

™ UseVariable Data
| I

el e

Default |
0K@ | Cancel |

Setup ltems Setup Description

Set IP address of the External Device.

IP Address

» Check with a network administrator about IP address. Do not set the duplicate IP
address.

Use an integer from 1024 to 65535 to enter the port No. of the External Device.

Port No. « For the port number, set the value that "251" is added to the set port number with
External Device.

For example, if "773" is set to the port number with External Device, set "1024" to the
port number of Device Setting.

Put a check in the box when using variable data, and select variable data.

Use Valiable Data = ] )
"5.4 When Using a Variable" (page 32)
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MICREX-SX Series Ethernet Driver

4.2 Setup Items in Offline Mode
NOTE » Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode

or about the operation.
Cf.  Maintenance/Troubleshooting Guide "Offline Mode"

« The number of the setup items to be displayed for 1 page in the offline mode depends on the
Display in use. Please refer to the Reference manual for details.

B Communication Settings
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

| Cormm, Device

MICRER-5SH Series Ethernet [TCP] Page 1/1
Port MNo. < Fixed o futo
| 1024 [w [l |
Timeout(s) 3w la
Retry f o a
Wait To Sendims) 0w a

2007/10/15
Back 20

: 18/1
Exit 0946

Setup ltems Setup Description

Set the Port No. of the display. Select either of [Fixed] or [Auto].
When you select [Fixed], use an integer from 1024 to 65535 to enter the port No. of the dis-

Port No. play. When you select [Auto], the port No. will be automatically assigned regardless of the
entered value.

Timeout (s) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
response from the External Device.

Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how

many times the Display retransmits the command.

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

Wait To Send (ms) packets to transmitting next commands.

GP-Pro EX Device/PLC Connection Manual 12



MICREX-SX Series Ethernet Driver
|

B Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device
you want to set from the displayed list, and touch [Device Settings].

Setup ltems Setup Description

Select the External Device for device setting. Device name is a title of External Device set

Device/PLC Name with GP-Pro EX.(Initial value [PLC1])

Set IP address of the External Device.

IP Address

Check with a network administrator about IP address. Do not set the duplicate IP address.

Use an integer from 1024 to 65535 to enter the port No. of the External Device.

Port No. « For the port number, set the value that "251" is added to the set port number with
External Device.

For example, if "773" is set to the port number with External Device, set "1024" to the
port number of Device Setting.

GP-Pro EX Device/PLC Connection Manual 13



5 Supported Device

MICREX-SX Series Ethernet Driver

Range of supported device address is shown in the table below. Please note that the actually supported range of
the devices varies depending on the External Device to be used. Please check the actual range in the manual of

your External Device.

Enter the External Device address in the dialog below.

* When the communication unit and the Input/Output unit are used at the same time, Input/
Output Memory cannot be used.
For address settings in GP-Pro EX, use Standard Memory and synchronize the Standard
Memory address with Input/Output Memory address in External Device.

B When [Addressing Mode] is "Direct"

Device/PLC [PLCT =]
1 Addressing Mode: * Direct = Variable
\gx No.
fi o e =] [oooo.00 —)3
/ Back | e
2 7|89
4|56
1] 2] 3
1] Ent

1 Enter [SX No.] (Input/Output Memory) or [CPU NO.] (Standard/Retain/System Memory).

2 Select a device.
3 Enter the address.

GP-Pro EX Device/PLC Connection Manual
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MICREX-SX Series Ethernet Driver

B When [Addressing Mode] is "Variable"

|i: Input Address H

Device/PLC [PLCT

1 Addressing Mode: = Direct * “ariable
\h_ADDEF!.LADDEF!V

=

2 ————{5TRUCTY [000LINT_0001.INT_0000 [0 ——T—3
|
=

L

= S_THUCT'I
= [oon)
© & INT_oom — 54
[ 1T 0000
QoL_oooo
DIMT_00o0
BOOL_0001

KN

Ent

1 Select a worksheet.

2 Enter the address.

3 When inputting a bit address, select the bit position of bit address.

4 variable data is displayed. The address can be entered by double-clicking the displayed variable.

5" m Making New Variable Data" (page 37)

NOTE « The variables where derived data type of 3 or more hierarchies are defined will not be
displayed.

GP-Pro EX Device/PLC Connection Manual 15



MICREX-SX Series Ethernet Driver

51 SPH200
B NP1PH-08
This address can be specified as system data area.
Device Bit Address Word Address 32bits Remarks
Ut Memmor %IX03.000.00 - %IWL1.000 - "
P y %IX0.511.15 %IWD.511
9%QX[1.000.00 - %QWLI.000 - "
Output Memory %QX[1.511.15 %QWL.511
9%MX.1.00000.00 - 9%MWII.1.00000 - v *3
Standard Memory 9%MX[1.1.04095.15 %MW.1.04095 [LIH|
Retain Menmo 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
ry %MX[1.3.2047.15 %MWII.3.2047
Svstem Mermor 9%MX[1.10.000.00 - 9%MWII.10.000 - x
Y y 9%MX[1.10.511.15 %MW.10.511

*1  Input/Output Memory Address Designation is as shown below.
« Bit Designation
%I1X0.0.0
Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)
» Word Designation
%IWO.0
Address (Word No.)
SX Bus Unit No. (1 to 238)
NOTE « Please refer to the SX Bus Unit No. details in the manual of External Device.
*2  Standard/Retain/System Memory Address Designation is as shown below.
« Bit Designation
%MX0O.1.0.0
Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
» Word Designation
%MWLO.1.0
LAddress (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
*3  Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer

to the manual of External Device).

GP-Pro EX Device/PLC Connection Manual 16




MICREX-SX Series Ethernet Driver

-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

GP-Pro EX Device/PLC Connection Manual 17
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B NP1PH-16
This address can be specified as system data area.
Device Bit Address Word Address 32bits Remarks
ot Mermo %IX[1.000.00 - 9%IWL1.000 - .
P ry 9%IX[1.511.15 %IWI.511
9%QX[1.000.00 - 9%QWL1.000 - .
Output Memory %QX[1.511.15 %QWL1.511
9%MX[1.1.00000.00 - 9%MWII.1.00000 - vy %3
Standard Memory 9%MX[1.1.08191.15 %MW.1.08191 [LIH|
Retain Memor 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
y 9%MX[1.3.4095.15 %MWII.3.4095
Svstem Memmor 9%MX[1.10.000.00 - 9%MWII.10.000 - v
Y y %MX[1.10.511.15 %MWI.10.511

*1

*2

*3

Input/Output Memory Address Designation is as shown below.
« Bit Designation

%I1X[.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

« Word Designation

%IWLO.0
Address (Word No.)
SX Bus Unit No. (1 to 238)
NOTE I ¢ Please refer to the SX Bus Unit No. details in the manual of External Device.

Standard/Retain/System Memory Address Designation is as shown below.
« Bit Designation

%MX0O.1.0.0

Bit No. (0 to 15)

Address (Word No.)

Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

« Word Designation
%MWLI.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer
to the manual of External Device).

GP-Pro EX Device/PLC Connection Manual 18




MICREX-SX Series Ethernet Driver

-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

GP-Pro EX Device/PLC Connection Manual 19



5.2 SPH2000

B NP1PM-48R / NP1PM-48E

MICREX-SX Series Ethernet Driver

This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks
Ut Memmor %IX03.000.00 - %IWL1.000 - "
P y %IX1.511.15 %IWL.511
9%QX[1.000.00 - %QWLI.000 - "
Output Memory %QX[1.511.15 %QWL.511
9%MX.1.00000.00 - 9%MWII.1.00000 - v *3
Standard Memory 9%MX[.1.65535.15 %MWII.1.65535 [LIH|
Retain Mermor 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
y %MX[1.3.8191.15 %MWI.3.8191
Svstem Memmor 9%MX[1.10.000.00 - 9%MWII.10.000 - x
Y y %MX[1.10.511.15 %MWLI.10.511

*1  Input/Output Memory Address Designation is as shown below.
« Bit Designation
%I1X0.0.0
Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)
» Word Designation
%IWO.0
Address (Word No.)
SX Bus Unit No. (1 to 238)
NOTE « Please refer to the SX Bus Unit No. details in the manual of External Device.
*2  Standard/Retain/System Memory Address Designation is as shown below.
« Bit Designation
%MX0O.1.0.0
Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
» Word Designation
%MWLO.1.0
LAddress (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
*3  Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer

to the manual of External Device).

GP-Pro EX Device/PLC Connection Manual 20



MICREX-SX Series Ethernet Driver

-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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B NP1PM-256E

MICREX-SX Series Ethernet Driver

This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks
out Memo %IX[1.000.00 - 9%IWL1.000 - .
P ry 9%IX[1.511.15 %IWI.511
9%QX[1.000.00 - 9%QWL1.000 - .
Output Memory %QX[1.511.15 %QWL1.511
9%MX[1.1.00000.00 - 9%MWII.1.00000 - vy %3
Standard Memory 9%MX[1.1.1703935.15 %MWI.1. 1703935 [LIH)
Retain Memor 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
y 9%MXC.3. 262143.15 %MWII.3.262143
Svstem Memmor 9%MX[1.10.000.00 - 9%MWII.10.000 - v
Y y %MX[1.10.511.15 %MWI.10.511

*1  Input/Output Memory Address Designation is as shown below.
« Bit Designation
%1X.0.0
Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)
« Word Designation
%IWO.0
Address (Word No.)
SX Bus Unit No. (1 to 238)
NOTE I ¢ Please refer to the SX Bus Unit No. details in the manual of External Device.
*2  Standard/Retain/System Memory Address Designation is as shown below.
« Bit Designation
%MX0O.1.0.0
Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
« Word Designation
%MWLO.1.0
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
*3  Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer

to the manual of External Device).
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-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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B NP1PS-32 / NP1PS-32R

MICREX-SX Series Ethernet Driver

This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks
Ut Memmor %IX03.000.00 - %IWL1.000 - "
P y %IX1.511.15 %IWL.511
9%QX[1.000.00 - %QWLI.000 - "
Output Memory %QX[1.511.15 %QWL.511
9%MX[1.1.0000.00 - 9%MWII.1.00000 - v *3
Standard Memory %MX[1.1.8191.15 %MWI.1. 8191 [LIH)
Retain Mermo 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
ry %MX[.3. 4095.15 %MWII.3.4095
Svstem Mermor 9%MX[1.10.000.00 - 9%MWII.10.000 - x
Y y %MX[1.10.511.15 %MWLI.10.511

*1  Input/Output memory Address Designation is as shown below.
« Bit Designation
%I1X0.0.0
Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)
» Word Designation
%IWO.0
Address (Word No.)
SX Bus Unit No. (1 to 238)
NOTE « Please refer to the SX Bus Unit No. details in the manual of External Device.
*2  Standard/Retain/System Memory Address Designation is as shown below.
« Bit Designation
%MX0O.1.0.0
Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
» Word Designation
%MWO.1.0
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
*3  Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer

to the manual of External Device).
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-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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MICREX-SX Series Ethernet Driver

This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks
out Memo %IX[1.000.00 - 9%IWL1.000 - .
P ry 9%IX[1.511.15 %IWI.511
9%QX[1.000.00 - 9%QWL1.000 - .
Output Memory %QX[1.511.15 %QWL1.511
9%MX[1.1.0000.00 - 9%MWII.1.00000 - vy %3
Standard Memory 9%MX[1.1.32767.15 %MWII.1. 32767 [LIH)
Retain Memor 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
y %MXC1.3. 16383.15 %MWI1.3.16383
Svstem Memmor 9%MX[1.10.000.00 - 9%MWII.10.000 - v
Y y %MX[1.10.511.15 %MWI.10.511

*1  Input/Output Memory Address Designation is as shown below.
« Bit Designation

%I1X[.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

« Word Designation
%IWL.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

* Please refer to the SX Bus Unit No. details in the manual of External Device.

NOTE I

*2  Standard/Retain/System Memory Address Designation is as shown below.
« Bit Designation

%MX0O.1.0.0

Bit No. (0 to 15)

Address (Word No.)

Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

« Word Designation
%MWLI.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

*3  Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer
to the manual of External Device).
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-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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MICREX-SX Series Ethernet Driver

This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks
out Memo %IX[1.000.00 - 9%IWL1.000 - .
P ry 9%IX[1.511.15 %IWI.511
9%QX[1.000.00 - 9%QWL1.000 - .
Output Memory %QX[1.511.15 %QWL1.511
9%MX[1.1.0000.00 - 9%MWII.1.00000 - vy %3
Standard Memory %MX[1.1.131071.15 %MWI.1. 131071 [LIH)
Retain Memor 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
y %MXC1.3. 32767.15 %MWL1.3.32767
Svstem Memmor 9%MX[1.10.000.00 - 9%MWII.10.000 - v
Y y %MX[1.10.511.15 %MWI.10.511

*1  Input/Output Memory Address Designation is as shown below.

« Bit Designation
%IX[.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

« Word Designation
%IWL.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

* Please refer to the SX Bus Unit No. details in the manual of External Device.

NOTE I

Standard/Retain/System Memory Address Designation is as shown below.

Bit No. (0 to 15)

Address (Word No.)

Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

*2
« Bit Designation
%MXO.1.0.0
« Word Designation
%MWL.1.0
*3

Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer
to the manual of External Device).
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-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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B NP1PS-245R
This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks
out Memo %IX[1.000.00 - 9%IWL1.000 - .
P ry 9%IX[1.511.15 %IWI.511
9%QX[1.000.00 - 9%QWL1.000 - .
Output Memory %QX[1.511.15 %QWL1.511
9%MX[1.1.0000.00 - 9%MWII.1.00000 - vy %3
Standard Memory %MX[1.1.262143.15 %MW1, 262143 [LIH)
Retain Memor 9%MX[1.3.0000.00 - 9%MWII.3.0000 - vy *3
y 9%MXC.3. 130047.15 %MWLI.3.130047
Svstem Memmor 9%MX[1.10.000.00 - 9%MWII.10.000 - v
Y y %MX[1.10.511.15 %MWI.10.511

*1  Input/Output Memory Address Designation is as shown below.
« Bit Designation

%I1X[.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

« Word Designation

%IWLO.0
Address (Word No.)
SX Bus Unit No. (1 to 238)
NOTE I ¢ Please refer to the SX Bus Unit No. details in the manual of External Device.

*2  Standard/Retain/System Memory Address Designation is as shown below.
« Bit Designation

%MX0O.1.0.0

Bit No. (0 to 15)

Address (Word No.)

Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

« Word Designation
%MWLI.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

*3  Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer
to the manual of External Device).
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-

When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
Always use a system area and reading area within the specified AT range.

Use high performance CPU system area with an address of %MW1.2048 or later.

Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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5.4 When Using a Variable

B Usable Device

The table below shows the Base Data Types of usable Variables.

Data Type Bit Address Word Address 32bits | Remarks
Single | _\/ARNAME>
Var
1D <VARNAME>.[0] to ) ) *1 %2 3
BOOL Array | <VARNAME>.[x-1]
2D <VARNAME>.[0].[0] to
Array | <VARNAME> [x-1].[y-1]
Single | < VARNAME >.00 to
Tag | < VARNAME >.15 < VARNAME >
INT
1D < VARNAME >.[0].00 to < VARNAME >.[0] to wq %)
\L/J\/IE\I)-ILD Array | < VARNAME >.[x-1].15 < VARNAME >.[x-1] “‘ﬂl
2D < VARNAME >.[0].[0].00 to < VARNAME >.[0].[0] to
Array | < VARNAME >.[x-1].[y-1].15 < VARNAME >.[x-1].[y-1]
Single | < VARNAME >.00 to
DINT Tag | <VARNAME >.31 < VARNAME >
UDINT
DWORD | 1P < VARNAME >.[0].00 to < VARNAME >.[0] to ) q *p
REAL Array | < VARNAME >.[x-1].31 < VARNAME >.[x-1]
TIME 2D < VARNAME >.[0].[0].00 to < VARNAME >.[0].[0] to
Array | < VARNAME >.[x-1].[y-1].31 < VARNAME >.[x-1].[y-1]
STRING | Sdle ; <VARNAME> N
Tag

*1  <VARNAME>: This is the complete "Variable" name including "Worksheet" name and "Structure"
name if it is a sub element of a structure. Maximum 255 characters including delimiters (*.") and
address part (e.g. bit position and array information).

e.g. BOOL type single tag in a Global Worksheet:

"CONF.MainResource.Global_Variables.BOOLVAR"
e.g. INT type single tag in a Local Worksheet:

"MainProgram.MainProgramV.INTVAR"
e.g. DINT type bit address: "MainProgram.MainProgramV.DINTVAR.30"
e.g. REAL type 2D array: "MainProgram.MainProgramV.REALARRAY[1].[2]"
e.g. DINT from a TIMER structure: "MainProgram.MainProgramV.TIMERVAR.PRE"
e.g. BOOL from a User Defined Structure :

"CONF.MainResource.Global_Variables. USERSTRUCTURE_
AMYTIMER.EN"

*2  Array dimensions: Up to 2D arrays can be created. When a "Variable" is an array, the size is defined.
Range of array elements: -32728 to 32767
Number of array elements: 32768
Usable memory size for 1 variable: Less than 65535 words

*3  BOOL type arrays: The External Device address must start on bit 0. e.g. %MX1.100.0

*4  Cannot be used with array access. "STRING" cannot be used as a part of the structure.
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« The following derived data types are available for address input with GP-Pro EX.
e Array data type
One-dimensional array
Two-dimensional array (an array of arrays)
« Structural data type
Structure
Avrray of structure
Structure of array
Structure of structure
« When specifying the address of the Eternal Device directly, always use a setting within the
specified AT range of the ladder software. We recommend using an AT-specified- variable for
the External Device used on the Display. Please refer to the MICREX-SX Series D300Win
<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range
and how to set it. When using a variable that is not AT-specified, variable needs to be imported
again and screen transfer needs to be executed if ladder program or variable is changed.
« Always use a system area and reading area within the specified AT range.
« Use high performance CPU system area with an address of %MW1.2048 or later.
¢ Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
» Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

To use a variable and Derived Data Type that were set by D300win with the GP-Pro EX, CSV file and IEC file
need to be imported.

CSV file and IEC file are exported by D300win.

Imported data is saved as variable data.

« Defined variable data can be used only with this driver. Therefore, variable data defined with
other drivers cannot be used with this driver. In the same way, variable data defined with this
driver cannot be used with other drivers.

* When IEC file meets any of the following conditions, it cannot be imported. Correct
inappropriate conditions and then import the file.
¢ There are two or more definitions or keywords (e.g. TYPE and END_TYPE) in 1 row.
(When a line break is inserted in the comment, the case is recognized that there are two or
more definitions or keywords in 1 row.)
e There is a structure where array variables are defined.
* There is an Alias of basic data type.
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W Setting Items of [Variable] List Dialog

Variable List

‘ariable Data Mame IVarDataD‘I

List Type IVariabIes

Worksheet

| LADDER.LADDERY

- STRUCTY
& [0] Z
-]

- 12]
v [3]

()8 | Cancel |

- [4] Impart |
+- [3] —

.. [6]

- [7]

- [4]

- [4]

B [10]

- [11] =l

MICREX-SX Series Ethernet Driver

Box

| Enter the file name of the variable data.

| Select data type to be listed.

Select a worksheet where the variable is registered.

Operation buttons. After selecting the data in the
[List], adding, deleting, or editing can be executed
here.

[View] indicates the content of data.

[Import] imports variables and data type.

. The cursor is moved to the variable, and data type
and comments are displayed.

| Variable, data type, array, and worksheet that are
registered in the variable data are displayed.
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B Importing Variable and Data Type

1 Set variable, data type, array, and worksheet with D300win.
Version of D300win that is supported is VV3.1.0.0 or later.

2 Select [Export] from the [File] menu and select the data to be exported.
Data below needs to be exported.

Data to be exported Description File type
Cross reference Variable and worksheet Csv
IEC 61131-3 Data type and array IEC

3 Make [Individual Device Settings] dialog box displayed with the GP-ProEX, and put a check to [Use Variable
Data]. Then click [New].

&* Individual Device Settings

PLC1
IP &ddress I 192 168, 0. 1
Part N, I‘I 024 ﬁ

Fleaze zet the value that you add “'251" to the port
number you have set for the Device/PLC.

‘ariable Data

¥ UseVariable Data

Ll

New | it |

Default |
0K@ | Cancel |

4 Enter the name of variable data to save the setting in the [Variable Data Name].

Variable List

‘ariable Data Mame IVarDataD‘I

List Type IVariabIes LI

Worksheet I LI

Add

Delete

E dit

e

dild

Import

()8 Cancel
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|
5 Click [Import] to import CSV file and 1EC file that were exported in the Procedure 2.
Import IEC file first followed by CSV file.

Select File to Import Yariables or Derived Data Types From EHE
Look in: Il'f) Database j & = EB-
datatype.iec

Desktop

L

My Documents

File name: Idatatype.iec: j Open I
Filez of type: I IEC files [*iec) j Cancel |
A

+ When CSV file including variable with the user-defined data type is imported prior to IEC file,
an error, "Unknown Data Type was found" is displayed and variable is not imported. Import
IEC file first in order to register the user-defined data type.
« Arrays, structures and parameters whose name length exceeds 30 single-byte characters
cannot be imported. Set the name length to 30 single-byte characters or less and then import
them.

6 Confirm the registered data and click [OK].

Variable List

‘ariable Data Mame IVarDataD‘I

List Type IVariabIes LI

Workshest |LADDER LADDERY =

- BOOL_0000 Add
- DINT_0000
NT_0000 Delete
- STRUCT1

E dit

e

dildds

Import

()8 Cancel
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B Making New Variable Data

If variable data is not imported, make variable data using the following procedures.
@ Making a Worksheet
1 Select "Worksheets" from the [List Type] of the [Variable List] dialog box.

Variable List

‘ariable Data Mame IVarDataD‘I

List Type IWorksheets LI

Worksheet I LI

Add

Delete

E dit

e

dildds

Import

()8 Cancel

2 Click [Add] to display [Worksheet] dialog box.
3 Enter "Configuration", "Resource/Program" and "Worksheet" and click [OK].

Configuration IEI_SX
Fesource / Program |F|_81 17
worksheet IGIobaI_VariabIes

(0]8 | Cancel |
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€ Making Variable
1 Select "Variables" from the [List Type] of the [Variable List] dialog box.

Variable List

‘ariable Data Mame IVarDataD‘I

List Type IVariabIes LI

whorksheet I Config ReswWorkSheet LI

Add

Delete

E dit

e

dild

Import

()8 Cancel

2 Click [Add] to display [Variable] dialog box.

NOTE » To add a variable, the worksheet needs to be set.

Make the worksheet before making the variable.

&~ " @ Making a Worksheet" (page 37)

3 Enter "Name", "Data Type", "Address" and "Comment" and click [OK].

Mame
JINT_doon
[rata Type
JiINT
Comment
[t

L

Address

|3Mw1.0000000 |

()8 | Cancel |
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@ Making Derived Data Type
1 Select "Structures" from the [List Type] of the [Variable List] dialog box.

Variable List

‘ariable Data Mame IVarDataD‘I

List Type I Structures LI

Worksheet I LI

Add |
Delete |
Edit |
Yiew |
Import |

()8 | Cancel

2 Click [Add] to display [Derived Data Type (Structure)] dialog box.

3 Enter "Derived Data Type Name" and "Name" and "'Data Type" of Member included in "Derived Data Type", and
click [OK].

Derived Data Type (Structure}

Derived Data Type Mame

JKOUZOUTAN
Members
Mame | [rata Type
INT_0000 INT
| |B0OL_000o BOOL
'» |DINT_DDOD DINT
*

()8 Cancel
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€ Making an Array
1 Select "Arrays" from the [List Type] of the [Variable List] dialog box.

Variable List

‘ariable Data Mame IVarDataD‘I

List Type IArrays LI

Worksheet I LI

Add

Delete

E dit

e

dildds

Import

()8 | Cancel

2 Click [Add] to display [Derived Data Type (Array)] dialog box.
3 Enter "Array Name", "Data Type", "Start Element" and "End Element" and click [OK].

Derived Data Type (Array}

Aray Mame
[wORD1_10_ARRAY

[rata Type
|waRD

Start Element

=

lo =
=

I

End Element
|10

Ok I Cancel
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MICREX-SX Series Ethernet Driver

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

NOTE I « When using a variable, device code and address code cannot be used.
. . Device Code
Device Device Name Address Code
(HEX)
%IX
Input Memory 83 Word Address
%IW
%QX
Output Memory 84 Word Address
%QW
%MX1
Standard Memory 80 Word Address
%MW1
%MX3
Retain Memory 81 Word Address
%MW3
%MX10
System Memory 82 Word Address
%MW10
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7 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error

Occurrence Area)"

. Each description is shown below.

Item

Description

No.

Error No.

Device Name

Name of External Device where error occurs. Device name is a title of External Device set
with GP-Pro EX. (Initial value [PLCL1])

Error Message

Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

« IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
« Device address is displayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal [Hex]".

Display Examples of Error Messages
"RHAAOQ35: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

-

Refer to your External Device manual for details on received error codes.
Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the

error messages common to the driver.

W Error Code Unique for Driver

Error Code Description

0x10 CPU Error: An error occurs in the CPU and a command cannot be executed.

0x11 CPU in operation: Command cannot be executed because CPU is in operation.

Ox12 Command cannot be executed: Due to CPU's key switch condition, a command cannot be
executed.

0x23 During transmission interlocking: Transmission is interlocked due to a loader command from
another device.

0x28 During command processing: Requested command cannot be executed because other
command is in process.

Ox2B During other loader processing: Request command cannot be executed because loader is in
process (program changes).

OX2F Initialization incomplete: Requested command cannot be executed because system is
initializing.

0x44 Memory addressing error: Specified address exceeds effective area.

0x45 Memory size over: Address + reading/the number of written words exceeds the effective
area.

Continues to the next page.
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Error Code Description
OXAO Designated command destination error: No module exists at the designated destination
number.
OxA2 No command response: No response data from destination module.
0xA4 SX bus sending error: Error occurred in SX bus, and commands cannot be exchanged.
O0xA5 SX bus NAK: NAK occurred in SX bus sending, and commands cannot be exchanged.

m Error Message Unique for Driver

Error Code Error Message Description
"(Node Name):The number of specified It occurs when accessing a non-existing CPU
RHxx128 destination module is not existed.(Error No., and SX No.
Code: [Hex])" Designate existing module.
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